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Software Release and Version Change Log for NetAnalysis 

 

1.37.0.9343 (1.37h) 

Release Date: 11th December 2009 

• Change: Weekly, Daily and Cache secondary dates now show UTC value 

• Change: HstEx 2.12e will now allow access to mounted non-windows accessible file systems 

 
 

1.37.0.9121 (1.37g) 

Release Date: 1st May 2009 

• Change: All executables and setup are now digitally signed for security and authenticity 

• Change: HstEx 2.12d digitally signed 

 
 

1.37.0.9111 (1.37f) 

Release Date: 21st March 2009 

• Change: HstEx 2.12c now remembers file type setting on open file dialogue 

• Change: HstEx 2.12c now extracts Safari for Windows data 

• Bugfix: CR20010 HstEx - Issue with recovering Safari Plist data with the same structure as History 

 

1.37.0.9067 (1.37e) 

Release Date: 8th March 2009 

• Bugfix: CR10056 tag column not displaying correctly in some foreign language systems 

 

1.37.0.9030 (1.37d) 

Release Date: 30th January 2009 

• Bugfix: CR10092 Check for update not opening correct file/page 

• Bugfix: CR20009 HstEx - Runtime error 45602 drive in use (codemeter) 

• Bugfix: CR20008 HstEx - Runtime error 94 invalid use of null on reading logical/physical devices 

• Change: Includes release 2.12b of HstEx 

 

1.37.0.9018 (1.37c) 

Release Date: 18th January 2009 

• Bugfix: CR10086 NetAnalysis will not install correctly on Microsoft Windows Server 2008 

• Bugfix: CR10084 NetAnalysis will not install correctly on Microsoft Vista 

• Bugfix: CR10076 Weekly INDEX.DAT Last Visited date is incorrect in some circumstances with inverted bias being added 

• Bugfix: CR10074 Older NetAnalysis versions incorrectly identifying HstEx v3 File Format 

• Bugfix: CR10072 Read Only error on cancel open workspace 

• Bugfix: CR10065 Check for Software Update Error 13 

• Bugfix: CR10060 User Interface - grid not aligning left under certain conditions 

• Bugfix: CR10059 User Interface - error on cancel 

• Bugfix: CR10050 Read only error when opening workspace 
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• Bugfix: CR10021 Problem with losing tagged records 

• Bugfix: CR10009 Hit counter sometimes contains spurious values 

• Change: Includes release 2.12a of HstEx – completely rewritten from the ground up 

• Bugfix: CR20004 – HstEx - typing error in dialogue box title bar “Bainary” 
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1.37.0.0030 (1.37b) 

Release Date: 19th November 2006 

• Change: CR10053 Change some of the tool windows from fixed size to allow resizing 

• Bugfix: CR00048 Issues with the setup installing on x64 resolved 

• Bugfix: CR00046 Escape not activating cancel on search keyword screen 

• Bugfix: CR00045 Floating cell tips have vanished in grid view 

• Change: CR10042 URL view window font is too small 

• Change: CR10036 Decode URL window cannot be resized 

 

1.37.0.0014 (1.37a) 

Release Date: 23rd May 2006 

• Bugfix: CR10044 File Exists column icons have vanished 

• Bugfix: CR10039 Jet database error when double clicking on read only workspace file 

• Bugfix: CR10038 PDF printing – data is not changing between prints so wrong data is being printed 

• Bugfix: CR10037 Read only workspaces not opening properly 

• Bugfix: CR10035 FTP entries shown as unknown  

• Bugfix: CR10034 WMV missing from movie filter 

• Bugfix: CR10032 Character [] causing filters to fail in keyword list / normal filter search 

• Bugfix: CR10031 Character ‘ causing filters to fail in keyword list search 

• Bugfix: CR10028 AOL icon not appearing for AOL type entries extracted from ARL file 

• Bugfix: CR10022 Progress bar remains on screen at completion of extraction 

• Bugfix: CR10011 AOL entries from ARL extracted data not shown with AOL icon 

 
1.36.0.0126 

Release Date: 16th April 2006 

• Change: CR10043 Option in properties to change tag row colour to blue 

• Bugfix: CR10017 File>Exit from the menu does not prompt to save unsaved work 

• Bugfix: CR10010 MCP scheme not recognised 

• Bugfix: CR10008 Runtime error 32755 – user selected cancel on some file open / save dialog boxes 

• Bugfix: CR10007 Reporting error in group reports 

• Bugfix: CR10006 Error 3021 – no current record when verifying live cache entries 

 
1.36.0.0117 

Release Date: 23rd February 2006 

• Bugfix: CR10012 Problem with panes in the user interface 

 

1.36.0.0106 

Release Date: 21st November 2005 

• Bugfix: The Runtime Error 13 issue when used on systems other than when the regional setting is English UK or US 

• Bugfix: The issues with the PDF printouts not printing 

 

1.36.0.0020 

Release Date: 22nd August 2005 
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• Bugfix: Update for CPUs running DEP on SP2 (Data Execution Prevention)  

• Change: Cell Tips added – hover mouse over cell to get full tip of cell  

• Bugfix: Sorted bug where scroll track did not activate immediately when changed  

• Change: Cookies secure flag has now been updated as a result of new information  

• Bugfix: Rogue extra bookmark icon removed from secondary date column  

• Change: RTF export has been removed and PDF export added. 

• Change: MD5 column removed because of confusion that the MD5 was for the history file and not the resource. 

• Change: Copy column/record data to clipboard – individual cell data will be copied to the clipboard – right click to select  

• Change: Process cache and verify which files exist – new column added to show live cache files  

• Change: Some menu items have been consolidated to make them easier to use.  

• Change: New Google Desktop filter  

• Change: Advanced report format made clearer  

• Change: Index Type – Cached entries are regarded as CACHE instead of CONTENT  

• Change:  Some columns have been renamed to make the content clearer  

• Change:  Installer has been updated to ensure that Windows Scripting Host is installed properly. 

• Change: Netscape 4 parser completely re-written  

• Bugfix:  Leak parser has been re-written as some entries were not extracted.  

 

1.35.0.0051 

• Bugfix:  Weekly INDEX.DAT Last Visited date shows local time instead of UTC  

 

 

1.34.0.9027 (1.34a) 

Release Date: 19th April 2004 

• Change: Status column now shows time zone bias on daily IE entries 

• Change: System Log – This has been moved from Case Properties and is now available from the Reports menu 

• Change: Host List Window – There is a new host list window added which will show you “HOST” entries.  These entries are 
used by Internet Explorer to build the Hierarchical History view from within the software, so will allow you to see the sites 
that Internet Explorer would have recorded as a History Entry 

• Change: You can now navigate from HOST entries 

• Change: User Interface has been redesigned slightly to improve usability – Some Menu Items have been moved and 
consolidated, with some additional new features added.  The grid display has been improved considerably, making it easier to 
examine large amounts of data 

• Change: XP Menu User interface implemented to improve usability and general appearance 

• Bugfix: A number of minor bugs have been fixed such as menu items greying out unexpectedly, problems with sorting 
columns after an SQL query has been run, not always finding the data source when a report was run or missing INDEX.DAT 
files that were all in uppercase 

• Change: The HIT column has been reinstated.  This is particularly useful when examining the Master History INDEX.DAT file. 
 This file holds the master history list which shows the LAST time a site was visited.  It also holds the VISIT count.  To 
examine just the Master History file – filter by pressing the Select Index Filter type button from the menu.  (11th in from the 
left).  Columns can be switched on and off from the column menu 

• Change: Tagging has been improved – it is now possible to TAG all the records which are currently filtered.  It is also possible 
to remove the TAGS from currently filtered records.  To remove all TAGS – the recordset must be refreshed first by pressing 
F5 

• Change: Reporting has been improved - the advanced report has been updated so that the Secondary Date type is identified, 
along with the addition of the HIT counter.  This makes it more difficult for a suspect to say "I only visited that site once!" 
when the Visit Count shows 300+ 

• Change: The standard report has had the HIT counter added 

 
 
1.33.0.0023 

Release Date: 28th February 2004 

• Change: SQL – a number of new SQL filters have been added – including a filter to identify problems with time zone settings 
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• Change: Filters – New filters have been added along with new Investigation Items.  You can now identify additional picture 
types along with KAZAA Previewed items (Items previewed within KAZAA during download) including files accessed from 
Floppy Diskettes 

• Change: Crack URL Feature – there is a new feature for decoding and cracking URL records – simply select the record you are 
unsure about, right click and select Crack URL from the menu.  This will display a window showing the URL broken down into 
components such as Protocol, Host, Path, Data, Username, Password and Port Number 

• Change: History Extractor – the brand new updated history extractor can now be launched from within NetAnalysis 

 

1.32.0.0053 

Release Date: 5th September 2003 

• Change: Extraction engine tweaked for more accurate record extraction 

 

1.31.0.0144 

Release Date: 27th June 2003 

• Bugfix: Issue with Netscape Communicator date extraction 

• Bugfix: Error 3021 when tagging last record in the list 

 

1.30.0.5137 

Release Date: 15th March 2003 

• Change: Apple MAC bookmark file type added 

 

1.29.0.3062 

Release Date: 3rd March 2003 

• Change: SQL feature - add your own SQL queries to get the records you want  

• Bugfix: Printing should now work properly with US Paper sizes  

• Bugfix: File names in the recently used list now have truncated path rather than just filename  

• Change: Advanced report now shows the cached file name and the cache folder  

• Change: You can now export the standard print by selecting print export from the File Menu  

• Change: The check for software updates menu item is back. 

• Bugfix: Saved Workspace files will not have the hidden attribute set 

 

1.28.0.3033 

Release Date: 2nd February 2003 

• Change: Advanced report now shows the cached file name and the cache folder  

• Change: You can now export the standard print by selecting print export from the File Menu  

 

1.27.0.2329 

Release Date: 25th November 2002 

• Change: Slim, Reusable, Offline HTML and Graphics File Viewer (QDV.EXE)  

• Change: Decode UNIX date/time values in URLs and Cookies  

• Change: Enhanced URL and Cookie Value Decoding  

• Change: Cached Files now identified in Type Column  
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• Change: Save System log  

• Change: Filter Only History File Entries (i.e. no cache entries or cookies)  

• Change: Filter Only Cache Entries - easier to view files in cache  

• Change: Open All Identified History from a base folder location  

• Change: Full Path of History File now recorded  

• Change: Command Line updates to accept data from Encase  

• Change: Case Information can now be added to the Advanced Report  

• Change: Column hide - NetAnalysis now remembers which columns you have switched off  

• Change: Ordering in reports - in the Group Reports - secondary ordering by selected column  

• Bugfix: Filter Bar problem caused by Enter Key  

• Bugfix: Last digit of REDR entries being chopped off  

 
1.26.0.0200 

Release Date: 18th November 2002 

• Bugfix: Filter Bar - not handling the enter command correctly  

• Bugfix: In REDR entries - chopping of the last character  

 

1.25.0.2297 

Release Date: 24th October 2002 

• Change: Offline CACHE viewer for Internet Explorer  

• Change: Rebuild Web Pages and Update the Picture Links  

• Change: View the JPEG that the suspect viewed straight from the cache  

• Change: Multiple Keyword Searching  

• Change: Keyword Search List Import/Export  

• Change: Multiple Keyword - AND/OR Searching  

• Change: Improved URL decoder  

• Change: Cookie Field/Value Decoder  

• Change: Improved Comment Window showing the decoded URL as well  

• Change: Cookie decoder button on the toolbar for easy access  

• Change: Column which lists the CACHE Folder name  

• Change: Hits column  

 

1.24.0.2270 

Release Date: 27th September 2002 

• Bugfix: Runtime error when selecting properties  

• Bugfix: Runtime error when filtering between dates  

• Change:  Enhanced Cookie viewer and decoder  

 

1.23.0.0777 

Release Date: 5th September 2002 

• Bugfix: Runtime error when Properties Selected  

• Bugfix: Wrong page count on Group By Reports  

• Change: Marker in cookie view to show expired/active cookies  
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1.22.0.2232 

Release Date: 20th August 2002 

• Change: Cookie viewer and decoder  

 

1.21. 0.0132 

Release Date: 19th August 2002 

• Bugfix:  Username extraction on history type DAT files.  If the username contained more than one word, only the last word 
was extracted  

 

1.21. 0.0002 

Release Date: 9th August 2002 

• Change: Add Bookmark Comment feature. You can now add a bookmark comment to an individual URL record, which will be 
shown in the NEW Advanced Report. Records with bookmark comments can also be filtered for presenting as evidence.  This 
allows you to highlight search criteria or highlight the evidential importance of a particular URL 

• Change: Advanced Report.  This is a more detailed report that shows the bookmark comment and more detail than the 
standard report 

• Change: Decode URL feature. How many times have you seen this in a URL: 
%74%68%69%73%20%69%73%20%72%65%61%6C%6C%79%20%61%6E%6E%6F%79%69%6E%67%20%69%73%6 
E%27%74%20%69%74%21 – NetAnalysis will now decode these URLs and turn them into plain text so you can easily see 
what is happening.  Press CTRL – D to show the decode window 

• Change: Decode Window to show decoded URLs. Also has the ability to add Bookmark Comments from this view 

• Change: Online Storage Identification.  This feature will examine the URL data looking for any indication that the suspect has 
access to online storage 

• Change: Get Web Server Last Modified Date Identification. Select any URL, right click and select “Get Web Server Last 
Modified Date”.  NetAnalysis will then query the server and ask for the Last Modified date of the selected file or web page. 
 The will either be the Last Modified date of the file on the server, the last modified date of the page on the server or the 
header as embedded within a page.  Note that dynamic pages such as ASP, CGI scripts etc, will not have dates because of 
the way they are generated and the URLs recorded 

• Change: New CONTENT DATA column.  NetAnalysis now extracts ALL the content data from the content INDEX.DAT type 
files. Some services such as HOTMAIL actually add date and times in plain text to this location 

• Change: Visits column.  Certain files will have a flag to show how many visits have been recorded. The cookie INDEX.DAT 
records this data so it is now extracted and displayed.  The additional columns can be viewed when they are switched on from 
the View menu 

• Change: Status column. Netscape history can be partially overwritten at times and Netscape 6 has a flag to show whether the 
URL was actually typed by the user.  This information is now displayed in the Status column 

• Change: Comment column. Will show the first line of any Bookmark Columns added 

• Change: Default search filter fields changed so that when you enter a search it will filter not just the URL but the Page Title, 
the URL Filename   

• Change: Filter Search amended so that you don’t miss important key words.  For example if you are looking for a search 
engine submission where the user searched for “Evidence Eliminator”, the search may look like “evidence+eliminator”.  If you 
searched for “Evidence Eliminator” you would miss the hit.  I have changed this so any characters separating the words will 
now be picked up 

• Change: Check for NetAnalysis updates. From the help menu, you can now check to see if there is a newer version of the 
NetAnalysis software.  If there is, NetAnalysis will open the download page for you 

• Change: Support for the MOZILLA 1 browser – extract Mozilla history 

• Change: Right click and copy formatted data to the clipboard 

• Change: You can now export all the reports in RTF format 

 

1.20.0.0025 

Release Date: 12th July 2002 

• First commercial release 

• Change: Licensing unlock key  

• Change: Identify possible passwords and usernames  

• Change: Changed the date/time extraction so that all date/times pulled out now regardless of whether they match the Last 
Visited date  
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1.18 – 1.19 

Versions skipped for release version 
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1.17.0.0021 Beta 17 

Release Date: 30th June 2002 

• Change: Exclude menu – exclude some URL types from view  

• Change: Reports – new analytical reports – view the data in different formats  

• Change: Summary report – counts visits to each host and presents report  

• Change: Group by User Report  

• Change: Group by Index type Report  

• Change: Group by History File Report  

• Change: Group by Hostname Report  

• Change: Hide all columns feature so you can add the ones you want  

• Change: System log will list all internet files analysed with their size and MD5  

• Change: Changed custom date format to prevent incorrect formats being used  

• Change: Added identification for MS Front Page activity  

• Change: Added identification for Code log entries  

• Bugfix:  Blank page in between every print now fixed  

• Bugfix:  Printer Orientation problem fixed  

 
1.16.0.0035 Beta 16 

Release Date: 28th June 2002 

• Change: Support for Extracting Netscape History from Unallocated Space  

• Change: Encase E-Script which extracts MSIE URLs from Unallocated Space for NetAnalysis.  

 
 
1.16.0.0016 Beta 15 

Release Date: 25th June 2002 

• Change: Support added for LEAK entries  

• Change: Filter added for LEAK entries  

• Bugfix: Sorted the problem with dates not showing properly when the system regional settings were set to Swedish 

 
 
1.16.0.0005 Beta 14 

Release Date: 24th June 2002 

• Change: Support for Extracting Netscape History from Unallocated Space  

• Change: Encase E-Script which extracts MSIE URLs from Unallocated Space for NetAnalysis 

 

1.16.0.0000 Beta 13 

Release Date: 23rd June 2002 

• Change: Space Bar Tagging – now moves to the next record after tagging  

• Change: Now differentiates between Weekly and Daily Internet History   

• Change: Filter Daily or Weekly  

• Change: Daily/Weekly – Calculates the Date Period – shown in Column  

• Change: Identifies NEWS and new filter for News activity  

• Change: New column URL File – file name extracted from IE content files  

• Change: Support for Netscape FAT.DB  

• Change: Netscape support completely re-written to sort out previous date/time bugs  

• Change: Help file updated 
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• Change: In weekly INDEX.DAT files – last visited dates now identified  

• Change: Support for different time zones – set your time zone!  

• Change: Encase E-Script to extract Internet History from Unallocated Space!  

• Second Date Column renamed to “Secondary Date” to avoid confusion  

• Change: Primary Date now shows NetAnalysis Time Zone settings  

• Change: Simple Audit log which records date/time analysis commenced, time zone setting & investigator  

• Change: Extracts Content type and File Size from Cache Type Files  

• Change: Extracts cache file name from content INDEX.DAT files  

• Change: Cookie file name now shown in URL File column  

• Change: Status column for Netscape to show deleted URL entries  

• Change: Identifies partially overwritten URLs from Netscape cache  

• Bugfix: Limit on file size now sorted – history files over 50 Meg can now be opened  

• Change: Keyboard shortcuts: CTRL + END – takes you to last entry  

• Change: Keyboard shortcuts: CTRL + Home – takes you to first entry  

 

1.15.0.0078 Beta 12 

Release Date: 2nd June 2002 

• Change: Unique Host List View  

• Change: Filter the host from the host view window  

• Change: Splitter bars to adjust size of Full Text Window so you can adjust to any size you like 

 
 
1.15.0.0050 Beta 11 

Release Date: 27th May 2002 

• Change:   URL examination window - for very large URLs 

• Change:   Identify PNG files  

• Change:   Identify GOOGLE searches  

• Change:   Filter Bar to allow multiples column filters  

• Change:   Show Internet History Column Feature  

• Change:   Export data to MS Access Database  

• Change:   Export data to Excel CSV format (Comma delimited)  

• Change:   Host column where base URL is extracted  

• Change: Identifies Netscape cache filename so you can match a file to a URL  

 

1.15.0.0025 Beta 10 

Release Date: 26th May 2002 

• Bugfix:  System Error problem resolved  

• Code is smaller and faster as a result of hunting for the above bug  

 

1.15.0.0001 Beta 9 

Release Date: 26th May 2002 

• Bugfix: Extra carriage returns in exported files  

• Bugfix: Not realising the workspace was already saved 

• Bugfix: Extra carriage returns in exported files  

• Bugfix: Not realising the workspace was already saved  
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• Bugfix: System Error problem (I hope!!!!)  [SM8]  

• Change:   URL examination window - for very large URLs 

• Change:   Identify PNG files  

• Change:   Identify GOOGLE searches  

• Change:   Filter Bar to allow multiple column filters  

• Change:   Show Internet History Column Feature  

• Change:   Export data to MS Access Database  

• Change:   Export data to Excel CSV format (Comma delimited)  

• Change:   Host column where base URL is extracted  

 

1.14.0.0206 Beta 8 

Release Date: 21st May 2002 

• Change: Column merge facility - merge data in any column that matches  

• Change: Menus re-arranged, cleaned up and make more sense  

• Change: New filters menu added with many additional auto-filters  

• Change: Extended right click support with new features  

• Change: Filter this user, filter this day and filter by host feature added  

• Change: New menu icons to make things clearer - cosmetic enhancement  

• Change: Case properties added - select case reference and suspect name  

• Change: Powerful analysis capabilities added (to be enhanced over the next few weeks)  

• Change: Active reports print engine added  

• Change: In report, host analysis added - click on small icon in top left hand corner!  

 
 
1.14.0.0200 Beta 7 

Release Date: 20th May 2002 

• Change: Column merge facility - merge data in any column that matches  

• Change: Menus re-arranged, cleaned up and make more sense  

• Change: New filters menu added with many additional auto-filters  

• Change: Extended right click support with new features  

• Change: Filter this user, filter this day and filter by host feature added  

• Change: New menu icons to make things clearer - cosmetic enhancement  

• Change: Case properties added - select case reference and suspect name  

• Change: Powerful analysis capabilities added (to be enhanced over the next few weeks)  

• Change: Active reports print engine added  

• Change: In report, host analysis added - click on small icon in top left hand corner!  

1.14.0.0140 Beta 6 

Release Date: 16th May 2002 

• Bugfix: Bug which caused the filter to clear when a header was clicked now fixed.  

• Change: New way to carve out URLs from unallocated space should improve positive hits.  

• Change: IE3 support added 

• Change: Netscape 4/5 support added  

• Change: Most Recently Used Document list on the File Menu  

 

1.14.0.0115 Beta 5 

Release Date: 8th May 2002 

• Change: URL View window added 
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1.14.0.0107 Beta 4 

Release Date: 5th May 2002 

• Change: New way to identify user in almost all index.dat files 

• Change: Unique Record Identifier added  

• Change: Can now identify URL's from Weekly/Daily, Cookie, History and Content Index Types 

• Change: Can even identify the directory the INDEX.DAT came from in unallocated space chunks as well as the type  

• Change: Added find first and find next facility  

• Change: IE3 support added - still needs tweaking  

• Change: New Columns, Index Type and URN  

• Change: New filter for Content, History, Cookie or Weekly/Daily INDEX.DAT files  

• Change: Identify different URL types - icons added to make clearer  

• Change: Now flags https, cookies, ftp, Winhelp access, e-mail, file activity, resource file activity and unknown  

• Change: Cancel button added to the save or exit message box  

• Change: New Status Panel for Index type  

• Change: Column sort modified so that it doesn't reset horizontal position during a sort  

• Change: Column drag implemented - Press CTRL and drag the column  

• Change: When tagged URLs are filtered - the highlight colour is switched off (cosmetic request)  

 

1.14.0.0035 Beta 3 

Release Date: 1st May 2002 

• Bugfix: Bug where the software did not close properly if you had the wrong version of vbscript.dll 

 
1.14.0.0028 Beta 2 

Release Date: 3rd April 30th 2002 

• Bugfix: Bug where error was generated on cancel from Print Setup  

• Change: Added some ALPHA support for Netscape 4 and 5  

• Change: Added new functions for hiding columns  

• Change: Added function to resize columns to data width  

• Change: Added filter function to the menu with shortcut keys  

• Change: Second Date header to show Last Modified [Server]  

• Change: If you try to exit and your work has not been saved it now asks you if you want to save  

• Change: Removed the double click function on URLs to show full text - right click now  

 

1.14.0.0000 Beta 1 

Release Date: 15th February 2002 

• First beta version released for testing 

 

1.0 – 1.13 Alpha Versions 

Never Released – Internal only 


